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Introduction

In this eBook, you’ll learn about the basics of 
the Silhouette Alta® 3D Printer and how to use 
the Silhouette 3D™ software to create your own 
3D prints�

The Silhouette Alta® is a 3D printer, which is a 
machine that creates a physical object from a 
3D digital model� It does this by pushing plastic 
filament through a tiny heated nozzle, laying down 
many thin layers in succession�

What’s in the Box?

In the box, you have the Alta 3D printer, power 
and USB cables, white filament starter, a filament 
spool holder, a clear filament guide tube, the 
platform, platform tape, hex keys and a nozzle 
cleaner, a spatula, and keys�

Silhouette Alta®
delta 3D printer

A/C adapter and 
power cable

USB cable

Filament spool

Filament

Filament tube Spatula Small hex
key

Large hex
key

Nozzle
cleaner

Keys

Platform
(build plate) Platform tape

The filament spool holder is for holding the starter 
filament but is not necessary once you start 
placing full-size Alta filament spools on top� The 
spool was printed by your own machine in the 
factory to ensure the machine was working and 
calibrated before it shipped�
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Other Tools and Supplies

As you use your Alta, you may find a few more 
tools and supplies to be helpful:

 f Colored filament spools in various colors 
(PLA 1�75 mm)

 f Platform tape refills

 f Thinner spatula tool

 f Pliers, cutters, or scissors

 f Copy paper

Device Setup and Software 
Installation

The best way to get everything set up in order to 
start using your Alta is to visit Silhouetteamerica�
com/setup and select the Alta�

Sign in with your existing Silhouette account, or 
create a new account if you are new to Silhouette�

Step 1 has you fill out information about you and 
your machine� When you submit this information, 
the registration step is complete� Then you’re 
ready to continue on to each step�

Step 2 will guide you through setting up your Alta�

Step 3 has you download and install the Silhouette 
3D™ software�

Step 4 tells you where to access the free 3D 
shapes in the Library, but we’ll go through that 
soon when we dig into the software�

Step 5 is the final section, which gives you easy 
access to user guides, manuals, and additional 
resources�

Open Silhouette 3D™, and you can find references 
in the Help menu� This includes links to access the 
Startup Slideshow, the Silhouette 3D™ Manual, 
and Instructional Videos (you will be taken to the 
Alta YouTube playlist)�
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Calibration

Although your machine was calibrated before it 
was shipped, it’s possible that things moved a little 
during shipping, so it’s a good idea to calibrate 
your Alta when you are ready to start using it�

Calibrate your machine by first going to the 3D 
Print Tab in Silhouette 3D™ and choosing the 
middle icon that resembles the platform� This will 
walk you through the steps�

Take a piece of copy paper and cut off a strip that 
will fit inside the Alta compartment�

Click Start in Silhouette 3D™and put the 
paper under the nozzle as it moves to its three 
calibration points�

When the nozzle comes down, try to move the 
paper around� If you feel no resistance or if it’s 

difficult to move the paper, the Alta is not properly 
calibrated�

You should feel light resistance between the nozzle 
and the platform while your paper is sandwiched 
between them� Also listen for a friction sound as 
the paper rubs both surfaces�

If the paper is too easy to move, click Easy� If the 
paper is too hard to move, click Hard� If you feel 
and hear moderate resistance, click Normal�

Then the on-screen instructions tell you which 
direction to turn your hex key� Turn the hex key 
counter clockwise to tighten; clockwise to loosen� 
Turn only a small amount (about 30 degrees) 
at a time�

Test again with each adjustment at each position 
until you get it to a normal amount of resistance� 
The software guides you through all of this�

You can calibrate your machine as often as you 
feel it’s necessary� When your 3D prints are not 
sticking well to the print bed, calibration is the first 
thing to check�

Note: If you ever feel like your calibration is way 
too tight when it was normal recently, check to 
make sure no extra plastic is sitting at the end 
of the nozzle�
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Filament

To load the filament, click on the filament icon in 
the 3D Print tab�

Cut off any crooked or distorted ends so you’re 
loading a clean, blunt tip� This can be done with 
wire clippers or scissors� You don’t want to load 
filament with kinks in it�

Place the roll so it’s unrolling counterclockwise 
toward this eye loop and the filament entry�

Push the filament through the small eye loop on 
the top of the Alta, and then slide it through the 
clear filament guide tube�

Put the top end of the guide tube through the 
loop so the filament doesn’t wear away the loop 
as it moves�

Once you’ve got a couple inches poking out the 
end of the clear filament tube, press it into the 
hole until it stops� You do not need to push the 
lever� This positions the filament right up against 
the gear of the feed motor�
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Advance through the on-screen instructions in 
Silhouette 3D™ and click LOAD while applying 
light pressure on the filament in the hole�

Once the print head is heated, the feed motor will 
grab the filament and start to feed it automatically 
down the inner tube, at which point you can let go�

The filament will feed into the print head and 
extrude some filament to clear any previous color�

Insert the guide tube into the loading hole after the 
filament has finished loading� You don’t need to 
press the lever at all in this process�

To unload the filament in order to store it or switch 
colors, use the same filament button on the 3D 
Print Tab and follow the instructions to unload the 
filament� The print head on the Alta will be heated, 
extrude a little filament, and automatically unload 
the filament�

Once the filament has been unloaded, cut off the 
uneven end, and don’t let the filament get tangled 
on the spool�

Store your filament with desiccant in a moisture 
and air-resistant container so it doesn’t become 
brittle� Plastic bags might be adequate enough, 
depending on your environment and the quality 
of the plastic bag you are using, or you can use 
a storage tub with a seal if you have a lot of 
filament spools�

Platform Tape

Platform tape is already applied to the build plate 
when you get your machine� This provides the 
right kind of surface for the PLA filament to stick 
to the build plate as it prints�

You can generally keep the same platform tape 
on the build plate for multiple prints as long as it’s 
in good condition� If you get scratches or gouges 
in the platform tape, you’ll need to remove it and 
replace it with a new piece of platform tape�

Scratches, holes, and tears in the platform tape will 
cause flaws to be carried through your 3D prints� 
The solution for this is to replace the platform tape� 
Try to smooth out any bubbles that may appear 
as you remove your prints from the platform tape 
because bubbles will affect prints as well�
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If your prints aren’t sticking well to the platform 
and the machine is properly calibrated, it’s 
possible the platform tape has accumulated too 
much oil from your fingers, and the platform tape 
should be replaced�

To remove the platform tape, simply peel it off like 
a piece of tape� Then take a new piece, line it up 
with the notch on the platform with the backing 
still in place� Peel away the backing of the lower 
half of the platform tape while holding the top 
half in place� Smooth the bottom half down with 
the included spatula tool, and then peel away 
the backing of the top half� Smooth down the 
remaining half to finish the application�

Print a Simple Project

Let’s print a simple project from your Library so 
you can see how the machine works�

You can view or hide your Library by clicking these 
double arrows�

In your Library, go to the “Designs” folder > “Free 
with Machine” folder > “Alta” folder > choose 
Seaside Pendants > then the Anchor� Double-click 
the anchor to open it�

Do not resize or move the object for this 
first project�

Go to the 3D Print Navigation Tab, and leave 
the print-quality settings as Standard� The print 
estimate should be about 4–5 minutes�

Click Print� Here’s what happens next�

 f The print head moves into position 
over the well�

 f The print head is heated up�

 f You may hear noises, which are normal, as 
the Alta prepares the filament�

 f The print head extrudes a little filament�

 f A brim, or an outline around the design, 
is created�

 f The Alta starts slowly printing a first 
layer, and then it builds up the full design, 
layer by layer�
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You can print with the door closed, and open it if 
things look too hot and stringy�

The software lets you know when the print is 
finished� The print needs to cool for a few minutes 
before you touch it�

Once the filament has cooled, remove the print 
from the base� A spatula, a piece of paper, or pliers 
are all options you can use to help remove it� Try 
not to scratch the platform tape because it can be 
reused as long as it’s in good condition�

Software Overview and Basic 
Navigation

Let’s take a closer look at the Silhouette 
3D™ software�

When you open Silhouette 3D™, also known as 
S3D, you’ll see a workspace with a virtual build 
area, ready to hold designs for 3D printing� This 
can be text, preset 3D shapes, or designs from 
your Silhouette Library like this anchor�

You can even open designs from third-party 
sources that are in a compatible file format, such 
as �STL or �OBJ files�

Most of these tools should be familiar to you, so 
we won’t spend much time on the menu and every 
individual tool icon� You can read in detail about 
each tool in the Silhouette 3D™ software manual 
available through the Help menu� We’ll use the 
most common ones throughout this eBook�

Library:
 f As we mentioned before, click the double 

arrow to reveal or hide the Library�

 f When you are signed in, the Library will 
sync with your existing Silhouette Library if 
you have used Silhouette Studio® for other 
Silhouette machines�

 f The 3D Designs folder contains any 3D 
Alta designs you purchase from the 
Silhouette Design Store� Folders are listed in 
alphabetical order�

 f The “Free with Machine” folder contains 3D 
Alta designs that load when you connect 
and register your Alta�

 f To open a design from the Library, double-
click the design or click and drag it to the 
workspace�

Store Tab:

 f The Store Tab opens a web browser 
that takes you to the Silhouette Design 
Store� It automatically loads the 3D 
Printing category�

 f When you purchase 3D designs, they 
automatically load into the “3D Designs” 
folder in the Silhouette 3D™ Library�

Quick Access Toolbar:

 f One important area worth noting in the 
Design Tab is the Quick Access Toolbar� 
When you have a design selected, popular 
options appear here for functions like 
rotating, grouping, ungrouping, leveling 
to bed, centering to bed, and changing 
dimensions�
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 f To change the dimensions of a design, you 
can either lock the dimensions to adjust 
a shape proportionately or unlock them 
to change just one dimension, such as 
the height�

 f You will likely use the dimensions most 
often to make your shapes a specific size, 
but clicking the drop-down arrow also gives 
you the option to input the exact rotation or 
scale values�

Preferences:
 f You can change the unit of measurement 

from millimeters to inches in Preferences, 
which is found in Edit > Preferences�

Create and Manipulate Shapes

With the shape creation tool, you can create 
a cone, cube, cylinder, dome, pyramid, sphere, 
frustum of cone, torus (donut), hollow 
cylinder, or wedge�

Let’s practice with a wedge� Click on the wedge 
shape, and the object will center itself on the 
virtual platform (also known as the base)�

Zoom in or out with the mouse scroll wheel� 
You can find more zoom icons at the top of 
the window�

Change the orientation with a mouse right-click + 
drag, or with the Page Orientation Cube�

Drag the white corner handles of the selected 
shape’s bounding box to resize your shape 
proportionately� Drag the side handles to 
compress or expand the shape� Holding down 
the Shift key and dragging corner handle 
together allow you to change the dimensions 
disproportionately�

Click and drag the shape to move it�

To center the shape back on the bed, use 
the Center to Bed icon located on the 

Quick Access Toolbar�

Use the white center handle to adjust the height or 
thickness of a selected object� This is great for flat 
objects and text�



3D Printing Basics 11

Use the arrow that hovers above the object to lift 
the object vertically above the base� This is helpful 
if you’re stacking objects to create new shapes�

Use the Level to Bed icon on the Quick 
Access Toolbar to get it flush with the 

base again�

You have rotation handles on the 
selected object, or you can use the 

90-degree rotations in the Quick Access Toolbar�

And, of course, you have an Undo button, 
which is really useful�

For more information about the all the tools 
available in Silhouette 3D™, please refer to the 
manual available in Help > Manual�

Snapkits

Snapkits in Silhouette 3D™ allow you to build 
custom objects with predesigned pieces� These 
are from the “Design a Duck” Snapkit, both 
painted and unpainted�

These special 3D printing files let you customize 
your piece by mixing and matching different 
design elements�

Some Snapkits are included with your free Alta 3D 
designs, and you can purchase additional Snapkits 
from the Silhouette Design Store�

This Design a Duck Snapkit can be found in the 
“Free with Machine” folder�

When you double-click to open a Snapkit, you’ll 
find some divisions in the folder, such as a base 
and accessories�

Open the main piece by double-clicking it�

Notice the colored dots on the duck� Those are the 
predetermined snap points to put the other parts 
of the Snapkit in the right place�

Simply drag an accessory over from the Library, 
and you’ll notice it has its own colored dots� That 
means that piece will snap to the corresponding 
snap points on the main piece�

Drag a piece showing the dots toward the main 
piece with the same colored dots, and you’ll see a 
colored line appear� When you see that line appear, 
you can release your mouse and the object will 
snap into the correct position�
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If you don’t like it, you can replace it in some 
Snapkits by dragging over a new object that fits 
the same area� Or just delete just that piece 
by selecting it and pressing the Delete key on 
your keyboard�

This is a fun way to customize your 3D objects that 
are part of a Snapkit�

Sometimes Snapkit pieces are accessories for a 
character, sometimes they are for a lid to a box, 
and sometimes they are for text�

Objects that are snapped together are 
automatically grouped, so you don’t need to go 
through the extra step of grouping Snapkits� They 
become one piece in the 3D Print tab�

If it’s a Snapkit with a lid, the software knows 
when an object is a lid and will print that 
separately�

Although the pieces are colored on the Design 
screen, you can only print in one filament color� 
Both of these ducks were printed with yellow 
filament, but the colored version has been sanded 
with sandpaper to smooth out rough edges 
and then painted with a fine paint brush and 
acrylic paints�

Using 2D Designs

Silhouette 3D™ can use many of your existing 2D 
designs from your Library and convert them into a 
selection of 3D projects�

When you try to open a “regular” Library design, 
a pop-up box appears for you to select from six 
different import options, which are Extrusion, , 
Jewelry Box, Stencil Box, Stencil, and Wax Pendant�

Most individual 2D designs will not work with all 
six options but will work for a couple of extrusion 
choices� Try some out to see what works and 
what doesn’t�
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2D Design into a Basic Extrusion:

Extrusion is the “what you see is what you 
get” option�

Here’s a design that would be a cut file in 
Silhouette Studio®, but we’ve opened it in 
Silhouette 3D™ and printed it with the Alta�

To make this yourself, open “Echo Park Arrows” 
(Design ID #43091) and choose Extrusion�

Designs that are part of a set will open the entire 
set and automatically resize the set to fit the base�

Ungroup the designs and delete everything except 
the heart and its nearest arrow� Move the heart to 
the center of the nearest arrow�

Here’s an important thing to know� Even though 
they look like one piece here in the Design View, 
the pieces are not yet grouped�

Go to the 3D Print tab, and you’ll see they are 
still two separate pieces� The arrow will print first, 
and you can see at the bottom of the screen that 
the heart is a separate shape that will have to be 
selected separately to print�

If you want them to print as a single 
merged piece, you need to either 

Group or Weld them in the Design tab�

Select both the arrow and its overlapped heart and 
choose Group�

Go back to the 3D Print tab, and you’ll see they are 
now a single welded piece� It will print this arrow 
as you see it on the screen�

Note: Group and Weld behave the same 
for overlapped objects in Silhouette 3D™� 
However, welded objects cannot be later 
ungrouped, whereas grouped objects can be 
later ungrouped�
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2D Design into a Cookie Cutter Extrusion:

When you choose the cookie cutter option 
when opening a 2D Library design, the design 
is automatically converted to a cookie cutter 
with a base and thin walls, like this heart-shaped 
cookie cutter�

When opening a design with many pieces such 
as “11 Hearts” (Design ID #24813), the entire set 
opens, which is not ideal for cookie cutters� Simple 
shapes are best, not designs in large sets� If you 
want just one piece of the set, it may take some 
effort to single it out, and it may not convert well 
when resized�

A great way to single out a piece from a group 
or to make any modifications to a 2D design is 
to do it in Silhouette Studio® before opening it in 
Silhouette 3D™�

Go to Silhouette Studio® and open the same “11 
Hearts” collection�

Ungroup the set (twice), and delete everything but 
the frilly heart in the lower left corner�

In Silhouette Studio® version 4�2 or higher, you 
can choose the Alta Print Bed as your Cutting 
Mat choice so that you know the area you are 
working with�

Right-click on the design sitting on the Alta Print 
Bed, and choose Send to S3D > Cookie Cutter�

The design will open as a cookie cutter in 
Silhouette 3D™ and is ready to be printed in the 
3D Print Tab�

Note: You can also open Silhouette Studio® files 
from within Silhouette 3D™, and it will give you 
the same six extrusion options to choose how to 
open each 2D design�
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2D Design into a Jewelry Box Extrusion:

Now let’s look at the Jewelry Box option� This red 
heart box with a lid is an example of what you can 
make from a simple 2D heart design�

It automatically converts a design to a jewelry box 
with a lid� In this selection, the design protrudes 
from the lid base�

In Silhouette 3D™, choose the “Hearts” design 
(ID #177304), and select Jewelry Box when your 
import choices pop up�

This box prints in two pieces� Go to the 3D Print 
tab, send the first piece to print, and then let it 
cool when finished�

Remove it from the platform and put the platform 
back in the Alta before selecting the second part 
to print� Always let newly printed pieces cool 
before removing them from the platform�

The lid and base pieces match perfectly 
when finished�

It’s very similar to the Stencil Box, which 
you’ll see next�

2D Design into a Stencil Box Extrusion:

The Stencil Box choice automatically converts the 
design to a jewelry box with a lid, but this time the 
design is inset into the lid�

Follow the same steps as in the Jewelry Box 
explanation with the same Hearts design, but 
choose Stencil Box as the import option�

2D Design into a Stencil Extrusion:

The Stencil choice takes the design and makes 
holes in a flat plate to create a stencil�

To create appropriate stencils, you need a simple 
shape with no inner holes when choosing the 
Stencil import option� If you try to create a stencil 
with a design that has cutouts as part of the 
design, the cutouts will become separated when 
printed and will not be part of the final stencil�
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Design sets will include all pieces of the set in 
the stencil, and they cannot be detached in 
Silhouette 3D™�

Remember, you can single out pieces of a set in 
Silhouette Studio® before opening that altered 
design in Silhouette 3D™�

Note that when opening 2D designs, Silhouette 
3D™ will resize them to fit the virtual build 
plate� Large sets will be smaller in order to fit 
them on the platform� Saving as a �Studio3 file 
in Silhouette Studio® will not retain its size when 
opened within S3D, but designs resized to fit the 
Alta Print Bed cutting-mat choice then opened 
with a right-click directly to Silhouette 3D™ will 
retain their size�

2D Designs into a Wax Pendant Extrusion:

This #Tired print comes from selecting the Wax 
Pendant choice� It’s basically an Extrusion design 
placed on a solid base� This one is a great choice 
for turning phrases into keychains�

If you open this #Tired phrase (Design ID 
#229238) as an Extrusion, the letters are all 
separated and won’t stay together when printed�

Delete this, and then choose the same design as 
a Wax Pendant� You’ll see it’s automatically fused 
to a base�

To turn it into a keychain, resize it to 3 inches wide 
with the dimensions locked�
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Open a tube shape from the shape creation tools 
on the left�

Move the tube to the side and resize it to �25 
inches with locked dimensions, and then unlock 
the dimensions and change the height to 
�10 inches�

Move the tube into position so it’s overlapping 
the phrase� You can use your right mouse key and 
the scrollbar to change the view, and the spacebar 
with your mouse to pan�

Remember to select it all and choose Group 
or Weld so the loop and keychain design fuse 
together� Now you’re ready to select your print 
settings in the 3D Print tab�

Don’t forget you can create your own phrase or 
name in Silhouette Studio®, and then open it in 
Silhouette 3D™ as a Wax Pendant choice before 
resizing it and adding a keychain loop�

Now you can see how to get creative with your 
existing 2D designs with the six import options in 
Silhouette 3D™�

Text

The last key design feature of Silhouette 3D™ is 
text� In the software, you’ll find the Text Tool on 
left side of the Design workspace� Let’s explore 
one application of text by adding text to a 
badge design�

Click on the Text Tool and then type your text 
into the pop-up box and click OK� (Type Enter or 
Return between lines to create line breaks�)
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Now text options appear on Quick Access Toolbar� 
Your font list includes any installed on your 
computer� This project uses “LW Perfect Poster” 
(Design ID #238798)�

Choose the Center Justification option�

Notice the Snap point that appears with text, 
indicated by the red dot and red letter A�

Go to the “Free with Machine” folder, open the 
Keyring Blank Collection, and choose the Blank 
Shield Keyring� A snap point will also appear on 
the shield shape�

Drag the text to the shield� A line appears between 
the two objects when the snap points are ready to 
snap together�

The text snaps to the shape, and you can still 
adjust or edit the text by double clicking on the 
text� Resize smaller by dragging a corner handle of 
the text, and rotate it by dragging the rotate arrow�

There’s no need to group when you’ve used text 
snap points� The text automatically becomes 
attached to the design because of the snap points�

Several free designs have snap points for text, 
indicated by the red letter “A�”

As with the duck example for Snapkits, you 
cannot print in two colors, but you can print in a 
single filament color and paint the raised letters a 
different color�

Save Projects

One note about saving projects: If the design 
opens with the name of the design showing, we 
suggest going to File > Save As > Save to Hard 
Drive, or it might save to the Library under the 
same name it opened as, creating a duplicate title�

If it’s labeled as Untitled, you can use the normal 
Save icon to give it a name�
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Open Non-Silhouette 3D™ Files

Silhouette 3D™ will open many files designed in 
other 3D printing software�

This flexible dinosaur keychain is one example of a 
file found on Thingiverse�com as an �STL file� There 
are lots of free downloadable designs online that 
can be opened and printed in Silhouette 3D™�

If you know how to create 3D files in other 3D 
software and can save them as accepted file types, 
then you can generally open and print them in 
S3D� Keep in mind that the maximum size the Alta 
can print is about 5 inches high and just under 5 
inches wide�

3D Print Settings

We’ve looked at the 3D Print Tab already, but let’s 
talk more about the Print Settings in the software�

Once you have your design ready to print, go to 
the 3D Print navigation tab to check your settings 
and send the design to the Alta�

Each time you make an adjustment to the print 
quality or settings, you may notice a change on 
the slicing progress bar� This is just the software 
thinking through the layers breakdown, after which 

it will give you an estimated time and estimated 
filament usage�

Just like in the Design tab, you can use your mouse 
scroll bar in this view to zoom, or right-click + drag 
to change the view�
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When you have ungrouped pieces, look at the 
bottom task bar to see separately-queued pieces 
that can be selected and printed one at a time�

You have three default Quality settings: Draft, 
Standard, or High Quality� Your choice depends 
on what kind of print you are making and how 
finished-looking or durable it needs to be�

The box where the Print Settings are located also 
provides print estimates for time and material�

Advanced Print Settings: Click the Gear icon 
to find Advanced Print Settings� You can find 
details for all the advanced print settings in the 
manual, so we’ll just touch on a few commonly 
used settings�

Standard settings are appropriate much of the 
time, but if you do need to make adjustments 
when troubleshooting a print, this is where you 
can do it�

Layers and Perimeters: In the Layers and 
Perimeters tab you can adjust the temperature, 
among other things�

Infill: Infill is how much inner material it places 
for support�

Look at this partially printed duck�  Most of the 
design is relatively hollow, but the infill provides 
support and structure while the layers are building�

The density of infill changes with standard, draft, or 
high quality� Draft quality leaves bigger gaps in the 
infill, High quality has a denser infill, and Standard 
is in between�

The animation slider in the 3D Print tab lets you 
watch the entire print at various speeds or lets 
you choose a point in the process so you can see 
exactly how the print will come together� Different 
colors in the sliced design are associated with 
different speeds�
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Supports: When a design like this otter Cutipet 
has an overhang, you might want to try printing it 
with supports�

Click the gear icon again and go to the Supports 
and Adhesion tab� Check the box for Supports, 
and click Save Settings�

You’ll need to give a new name to the settings 
whenever you make adjustments because you 
can’t save over the three default quality settings�

The software automatically places support 
material under overhangs when supports are 
turned on so that the filament isn’t extruding hot 
plastic over open space�

It prints as you see it� The supports are easy to 
break off, and then you just have some cleanup to 
do where it was lightly attached�

Brim: This extra filament that prints along the 
outside before the main model is called a Brim 
(a�k�a� Skirt in the 3D printing world)�

It serves two purposes:

1� Makes sure material is flowing and sticking 
as expected

2� Helps with thermal insulation and prevents 
warping by providing more surface area 
for prints� You can increase the brim width 
and decrease the gap in the Advanced 
Print Settings�

 
There are more adjustments you can make in 
Advanced Print Settings as you try and fine tune 
your prints based on troubleshooting suggestions�
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Other icons you’ll find in the 3D Print tab are at the 
bottom of the window:

Home resets the print head position�

Calibration is very important, and we talked about 
that at the beginning�

We also talked about the Filament icon, which 
walks you through loading or unloading 
the filament�

You’ll find Manual Controls with the Filament 
choice as well� This allows you to heat the print 
head, reposition the print head, or feed the 
filament in case it’s stuck�

Finishing a Print

Your options for finishing a print are varied� If 
you feel like your print isn’t perfectly straight off 
the platform, you’re not alone� All 3D prints, not 
just those made with the Alta, might need some 
touch-ups�

You can

 f Leave the print plain

 f Sand it with sandpaper (dry or wet)

 f Paint it (acrylics with a paint brush or spray 
paint are both options)

 f Search for many online resources for 
finishing PLA prints (not exclusive 
to the Alta)
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Conclusion

We hope you feel more confident in what the Silhouette Alta® can do, how it works, and how to use the 
Silhouette 3D™ software to create or open your 3D prints�

This is a machine that rewards experimentation, so feel free to play with a lot of different design types and 
adjust your settings and finishing techniques as you continue to learn�

We also have a lot of resources on Silhouette101�com� Just search for “Alta” and you’ll find videos, 
instruction, troubleshooting tips, and inspiration to help you out�

Happy printing!

Designs Used:
Seaside Pendants - Anchor | Free with Alta machine | Page 8

Snapkit Design a Duck | Free with Alta machine | Page 11

Echo Park Arrows | Design ID: 43091 | Page 13

11 Hearts | Design ID: 24813 | Page 14

Hearts | Design ID: 177304 | Page 15

Hearts | Design ID: 118442 | Page 15

#Tired | Design ID: 229238 | Page 16

LW Perfect Poster Font | Design ID: 238798 | Page 17

Cutipets – Set 1 Otter | Free with Alta machine | Page 21
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